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Abstract 

Background: The aging process in skeletal muscle is often triggered by chronic oxidative stress that impacts extracellular 
matrix remodeling in the form of fibrosis and decreased motor function. Hibiscus sabdariffa Linn. (HSL) extract is known 
to be rich in polyphenol and anthocyanin compounds that have the potential as antioxidant agents. Objective: This study 
aims to analyze the potential of HSL intervention in regulating gastrocnemius muscle aging in an old rat model accelerated 
with D-galactose, reviewed from molecular, histopathological and functional aspects. Methods: A total of 18 rats were 
divided into three groups (n=6): Young Normal Group (NM), D-galactose aging acceleration Group (Ap), and D-galactose 
+ HSL Group (ApH). Aging induction was carried out using D-galactose at a dose of 200 mg/KgBW, daily for 8 weeks 
orally via tube. HSL supplementation was mixed in drinking water at a dose of 400 mg/KgBW daily for 8 weeks. The 
parameters tested included serum Malondialdehyde (MDA) levels, MMP-9 levels in muscle tissue, limb muscle grip 
strength, and the percentage of collagen deposition in histopathology preparations. Results: MDA levels and MMP-9 
enzyme activity in the Ap group were higher than the NM group (P < 0.001). The percentage of gastrocnemius muscle 
tissue collagen in the Ap group was lower than the NM group (P < 0.05). No differences were found in muscle grip 
strength between the Ap group and the NM group. MDA and MMP-9 levels in the ApH group given HSL supplementation 
were not significantly different from the NM group (P > 0.05). The percentage of gastrocnemius muscle tissue collagen 
in the ApH group was also not significantly different from the NM group (P > 0.05). Conclusion: Supplementation of 
HSL extract in the accelerated aging group was able to suppress MDA levels, reduce MMP-9 levels, and maintain the 
percentage of gastrocnemius muscle tissue collagen. Hibiscus sabdariffa Linn. extract proven to be effective in inhibiting 
the aging process of gastrocnemius muscle through the mechanism of lipid peroxidation chain cleavage and prevention of 
fibrotic remodeling, which contributes to the maintenance of the mechanical functional capacity of the muscle. 
 
Keywords: Hibiscus sabdariffa Linn., D-galactose, Malondialdehyde, MMP-9, Collagen Percentage, muscle grip 
strength, 
 
INTRODUCTION 

The Global Burden of Disease 2021 (GBD 2021) data confirms that the demographic transition of an aging 
population is a global public health challenge. 1A key manifestation of this challenge is the increasing burden of disability-
adjusted life years (DALYs), which is associated with the increasing prevalence of degenerative diseases due to the aging 
process.2 One of the organ systems affected is the musculoskeletal system, which is directly linked to disability in older 
adults. 3One of the conditions of age-related musculoskeletal decline is sarcopenia.4 Therefore, research to explore 
mechanisms that can inhibit aging-related muscle degeneration is very important. The muscle aging process is influenced 
by various factors such as decreased physical activity, hormonal disorders, oxidative stress, and chronic inflammation. 
5As the body ages, the capacity of endogenous antioxidant systems such as Superoxide Dismutase (SOD), Catalase (CAT), 
and Glutathione Peroxidase (GSH-px) decreases, leading to an increase in the accumulation of Malondialdehyde (MDA) 
and Reactive Oxygen Species (ROS) within cells. 6Excess ROS triggers oxidative stress, which is a condition of imbalance 
between free radical production and the body's ability to neutralize them. 7In the musculoskeletal system, the degeneration 
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process is characterized by changes in the structure and decreased function of cells and the extracellular matrix that make 
up muscle tissue. One of the changes that occurs is fibrosis in the muscle, which is an excessive accumulation of collagen 
fibers, especially types I and III, in the extracellular matrix (ECM) surrounding muscle fibers.8 Fibrosis causes decreased 
muscle elasticity and impaired transmission of contractile force, ultimately reducing strength and movement efficiency. 
8Microscopically, fibrosis appears as a disproportionate thickening of the ECM structure, often accompanied by an 
increase in the number of myofibroblasts. These myofibroblasts are the result of fibroblast differentiation under the 
influence of TGF-β1 Transforming Growth Factor-Beta 1 (TGF-β1), released during inflammation, and play an active 
role in collagen production. 8Under normal conditions, collagen plays a role in maintaining the elasticity of muscle fibers, 
but with aging, unbalanced collagen synthesis can actually cause problems.7  High collagen production is not balanced by 
proper regulation of its structure and quantity, resulting in excessive collagen accumulation in the ECM. This 
accumulation causes muscle fibrosis, which is the transformation of contractile muscle tissue into rigid, inelastic 
connective tissue. 7Aging directly affects the balance between collagen synthesis and degradation in muscle tissue. Under 
normal conditions, collagen homeostasis is maintained through the activity of synthesis by fibroblasts and degradation by 
Matrix Metalloproteinases (MMPs). With aging, the expression of MMPs, especially MMP-9, actually increases. This 
enzyme plays a role in the degradation of collagen and other ECM proteins, and its excessive activation accelerates the 
breakdown of collagen that has already been formed. This causes the collagen that has already accumulated in aging 
muscles to become increasingly unstable and susceptible to damage.9  Current research is developing the potential of 
natural ingredients as safe and effective anti-aging agents.10  Hibiscus Sabdariffa Linn. (HSL) Ethanol Extract contains 
flavonoids and quercetin, the main bioactive components of which act as anti-inflammatories that can inhibit aging 
processes such as hypertension, hyperlipidemia, cancer, and other inflammatory diseases of the liver and kidneys.11  To 
date, there has been no research on the effects of HSL ethanol extract on degenerative changes in muscle tissue in 
experimental animal models of accelerated aging. Aging research presents its own challenges. In vivo studies using mice 
are time-consuming and expensive. Therefore, an accelerated aging model that can mimic natural aging is needed. One 
method for creating an accelerated aging model is through D-galactose induction.12 Administration of D-Galactose causes 
an increase in ROS which then triggers oxidative stress, inflammation, mitochondrial dysfunction, and apoptosis which 
can accelerate the aging process.12 13 13 

 

METHODS 
This study is an in vivo experimental study using Sprague Dawley rats aged 14 weeks with a body weight of 200-

300 grams . The number of experimental animals in this study uses the ARRIVE (Animal Research: Reporting of in vivo 
Experiments) guidelines, namely 18 rats. Exclusion criteria: Rats were sick, injured, or died during the study. Rats were 
randomly divided into three groups, namely: (1) Young normal group (NM) which was terminated at the age of 17 weeks. 
(2) Aging acceleration group (Ap). Aging acceleration was carried out by D-Galactose induction which was given daily 
for 8 weeks orally through a tube at a dose of 200 mg/KgBW. (3) Aging acceleration group (ApH). In this group, along 
with oral D-galactose administration, Hibiscus Sabdariffa Linn supplementation was added at a dose of 400 mg/KgBW 
daily for 8 weeks orally by mixing it with drinking water. 
The parameters measured in this study include: 

1. Serum MDA Level Test 
malondialdehyde (MDA) levels in serum using the modified Thiobarbituric Acid Reactive Substances (TBARS) 
method by Buege and Aust (1978). The preparation of a standard curve (0 to 1.2 nmol) was carried out through 
gradual dilution of 6000 nmol MDA stock to a final concentration of 0.015 nmol in the third tube, then distributed 
into six series of tubes with a volume variation of 0-80 µL ) and topped up with H 2 O to 2000 µL. In sample 
processing, 200 µL of serum was diluted with 1800 µL of H 2 O and then vortexed . Each standard and sample tube 
was then added with 1 ml of 20% TCA and 2 ml of 0.67% TBA, vortexed , then heated together at 100 ° C for 10 
minutes. After reaching room temperature and vortexing again , all tubes were covered with parafilm and 
centrifuged at 3000 rpm for 10 minutes. The absorbance value of the supernatant formed was measured using a 
Spectrophotometer at a wavelength of 530 nm with a 1 cm cuvette, then the MDA concentration of the sample was 
determined based on the linear regression equation of the standard curve.13 

2. MMP-9 Level Test in Gastrocnemius Muscle Tissue Using ELISA 
Matrix Metalloproteinase-9 (MMP)-9 levels in mouse gastrocnemius muscle tissue were determined using the 
Mouse MMP-9 ELISA Kit ( CLG4B ELISA Kit , FineTest) according to the manufacturer's protocol. Gastrocnemius 
muscle pieces (50-100 mg) were washed and homogenized in cold PBS, then centrifuged at 5,000 × g for 5 minutes 
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to obtain the supernatant. 100 µL of standard or sample solution was added to each well, the plate was covered, and 
static incubation was carried out for 90 minutes at 37°C. Washing: The plate was washed twice without soaking. 
100 µL of standard or sample solution was added . µL of biotin-antibody working solution, the plate was covered, 
and static incubation was performed for 60 minutes at 37°C. Washing: The plate was washed three times and soaked 
for 1 minute each time. 100 µL of HRP-Streptavidin Conjugate (SABC) working solution was added, the plate was 
covered, and static incubation was performed for 30 minutes at 37°C. Washing: The plate was washed five times 
and soaked for 1 minute each time. 90 µL of TMB substrate solution was added, then the plate was covered, and 
static incubation was performed for 10-20 minutes at 37°C. (Accurate visualization control of TMB is required.). 
50 µL of stop solution was added and absorbance was read at 450 nm to determine MMP-9 levels based on a standard 
curve. 

3. Collagen Percentage Test Using Masson Trichrome Staining 
The preparation of histological preparations begins with gradual dehydration of post-fixation muscle tissue (10% 
NBF) using graded ethanol (70% to absolute), followed by clearing in xylol 2-3 times, each 30 minutes). The tissue 
is then infiltrated in liquid paraffin at a temperature of ±60 ° C 2-3 times, each 1-2 hours), then ( embedding ) in a 
mold, then cut into 4-6 µm thick using a microtome. Before staining, the preparation is deparaffinized on a hot 
plate (± 60 ° C, 15-30 minutes), immersed in two series of xylol (each 5 minutes), and rehydrated through graded 
alcohol (100% to 70%) and distilled water. For Masson's Trichrome staining , the tissue was re-fixed in Bouin's 
solution (56 ° C, 1 hour), then sequentially stained using Weigert's Iron Hematoxylin (10 minutes) for the cell 
nucleus, Biebrich Scarlet–Acid Fuchsin (10-15 minutes) for the cytoplasm, Phosphomolybdic/Phosphotungstic 
Acid (10 minutes) for differentiation, and Aniline Blue (5-10 minutes) to stain collagen. Then, the preparation was 
fixed with 1% acetic acid (2 minutes), rinsed with distilled water, and covered with a coverslip. The percentage of 
collagen in the muscle tissue was analyzed and documented using an inverted fluorescence microscope .14 For data 
analysis, the percentage of collagen in the muscle fiber area of each sample was calculated using high-quality image 
files (TIFF/PNG), then the Plugins > Color Deconvolution feature was run by selecting the Masson Trichrome 
vector to separate the color components into three new windows. Next, the Color_2 window (collagen component) 
was selected, then the segmentation threshold was set via the Image > Adjust > Threshold menu until the colored 
area accurately only covers the collagen tissue. Finally, open the Analyze > Set Measurements settings, ensure the 
Area Fraction and Limit to Threshold options are checked, then click Analyze > Measure to get the collagen 
percentage value in the % Area column.15 

 
4. Muscle Grip Strength Test 

Grip strength measurements of both hind legs were performed simultaneously. The net pull rod was held with the 
other hand and placed on the measuring frame at a 30° angle, tilted backward from the operator. Only the front legs 
were placed on the closer end of the net. The rat and the net pull rod were adjusted simultaneously and slowly until 
the rat could place its hind legs on the horizontal bar of the frame. The rat's body was ensured to remain upright 
with both legs attached to the rod. This technique was avoided if only one leg was attached. A slight force was 
applied and the hind legs were observed to ensure the rat was firmly gripping the rod. The rat was pulled horizontally 
from the measuring device until its hind legs were released from the rod. The net pull rod was moved at the same 
speed and direction as the hand holding the rat. The reading on the measuring device was recorded. The reading 
was reset to zero before being repeated. Three consecutive trials were conducted and the average value was taken. 
16Muscle grip strength tests were performed three times: before the intervention (D-Gal and HSL), in the fourth 
week, and in the eighth week before termination. 
 

5. Statistical Analysis 
Statistical analysis was performed using Graphpad Prism 8.0. The normality of data distribution was tested using 
the Shapiro-Wilk test. Homogeneity of variance was tested using the Levene test. Data with normal distribution and 
homogeneous variance were then tested using one-way ANOVA or two-way ANOVA. Data that were not normally 
distributed and had heterogeneous variance were tested using the non-parametric Kruskal-Wallis test. All results 
are presented as mean ± standard deviation or median (minimum - maximum). A p-value <0.05 is considered 
statistically significant. 

 
 



 
 
PROTECTIVE EFFECTS OF HIBISCUS SABDARIFFA LINN EXTRACT. PROTECTIVE EFFECTS OF HIBISCUS 
SABDARIFFA LINN. EXTRACT ON OXIDATIVE STRESS AND COLLAGEN DEPOSITION IN D-GALACTOSE 
INDUCED SKELETAL MUSCLE AGING IN RATS 
Gabriella E.O Andrianti et al 

Publish by Radja Publika 
               6601 
	

 
 

RESULTS 
Malondialdehyde level measurement Serum MDA was measured after termination at week 8 as an indicator of oxidative 
stress and cellular lipid peroxidation levels. According to the research data (Table 1, Graph 1), serum MDA levels in the 
Ap group ( 1.86 ± 0.164 nMol/mL ) were significantly higher than those in the NM group ( 1.45 ± 0.16 nMol/mL). ; p = 
0.0023. These results prove that the accumulation of D-galactose produces excessive 17Reactive Oxygen Species (ROS), 
thus causing lipid peroxidation and MDA production, a typical pathological condition commonly found in animal models 
of sarcopenia. These free radicals that are not compensated by the body's defense system will attack unsaturated fatty 
acids in the muscle cell membrane (sarcolemma), initiating a chain of lipid peroxidation, and releasing chronic pro-
inflammatory cytokines that accelerate muscle fiber atrophy while triggering the accumulation of interstitial fibrotic 
collagen matrix.18 

 
Figure 1. Serum MDA levels 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Information: 
*p < 0.05 
**p < 0.01 
NM: Young Normal Group; Ap: D-galactose acceleration model; ApH: D-galactose+HSL acceleration 
 

 
Table 1. Results of serum MDA level measurements 

 Group 
NM 

nMol/mL 
Ap 

nMol/mL 
ApH 

nMol/mL 
MDA levels 1.45 ± 0.16 1.86 ± 0.164 1.53 ± 0.20 

Data are displayed as Mean ± SD 
NM: Young Normal Group; Ap: D-galactose acceleration model; ApH: D-galactose+HSL acceleratio In contrast, 

serum MDA levels in the ApH group (1.53 ± 0.20 nMol/mL) were not significantly different from the NM group; p = 
0.7380. This demonstrates the ability of HSL to suppress lipid peroxidation end products and demonstrates the presence 
of antioxidant protective activity. The bioactive compounds polyphenols and anthocyanins in HSL likely stabilize radical 
compounds before they can damage cell membranes. 19These results strengthen the hypothesis that the protective effect 
of HSL in maintaining tissue integrity and inhibiting the aging process is through inhibition of oxidative stress.20 
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Figure 2. MMP-9 Levels in Muscle Tissue 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Information: 
*p < 0.05 
**p < 0.01 
NM: Young Normal Group; Ap: D-galactose acceleration model; ApH: D-galactose+HSL acceleration 

 
Table 2. Results of measuring MMP-9 levels in muscle tissue 

 Group 
NM 

pg/mg Protein 
Ap 

pg/mg Protein 
ApH 

pg/mg Protein 
MMP-9 Enzyme Activity 113.5 ± 13.89 154.7 ± 13.39 115.3 ± 11.64 

Information: 
Data are displayed as Mean ± SD 
NM: Young Normal Group; Ap: D-galactose acceleration model; ApH: D-galactose+HSL acceleration 
 

Referring to research data (Table 2, Graph 2), the activity level of the Matrix Metalloproteinase-9 (MMP-9) 
enzyme in gastrocnemius muscle tissue in the Ap group ( 154.7 ± 13.39 pg/mg Protein) was significantly higher than in 
the NM group ( 113.5 ± 13.89 pg/mg Protein) . These results indicate that D-galactose administration creates excessive 
ROS conditions and triggers oxidative stress. 21As a result, there is increased local inflammation in aging muscle tissue. 
This inflammation, in addition to accelerating muscle protein degradation, also affects collagen-producing cells such as 
fibroblasts and myofibroblasts. Fibroblasts are activated by inflammatory signals, especially types I and III, in response 
to tissue damage. 22In aging, unbalanced collagen synthesis actually causes problems. This accumulation causes muscle 
fibrosis, which is the replacement of contractile muscle tissue with stiff and inelastic connective tissue. 23On the other 
hand, ROS also damages the structure of collagen that has been formed through oxidation and fragmentation processes. 
Oxidized collagen tends to lose its tensile strength and elasticity and is more susceptible to degradation by proteolytic 
enzymes such as MMPs. Therefore, despite increased collagen production in aging muscle, the quality and strength of the 
tissue decline due to a combination of oxidative stress and chronic inflammation.24 In contrast, MMP-9 levels in the ApH 
group ( 115.3 ± 11.64 pg/mg Protein) was not significantly different compared to the NM group; p = 0.9707. This proves 
that HSL administration suppresses MMP-9 levels in the mouse model of accelerated aging. This therapeutic effect is 
thought to be influenced by the content of phytochemical compounds in Hibiscus sabdariffa Linn. extract, such as 
polyphenols and anthocyanins, which have high antioxidants to neutralize cellular free radicals. The structural impact of 
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HSL extract in controlling MMP-9 activity affects the structural protection of gastrocnemius muscle myocyte fibers . 
Controlled MMP-9 activity prevents excessive proteolysis of the main components of the skeletal muscle extracellular 
matrix (ECM), especially type IV collagen in the basal lamina. The ECM layer not only optimizes the efficiency of lateral 
muscle contractile force transmission but also ensures the stability of the satellite cell niche or muscle stem cell micro 
niche required for cellular repair and regeneration processes.25  

Figure 3. Collagen Percentage 

 
* p < 0.05 
** p < 0.01 
Data is displayed in Median 
NM: Young Normal Group; Ap: D-galactose acceleration model; ApH: D-galactose+HSL acceleration 
 

Table 3. Results of collagen percentage measurements 
 Group 
 NM Ap ApH 

Collagen Percentage 15.84 (15.93-24.82) 34.34 (30.21-40.58) 20.91 (20.47-22.78) 
* p < 0.05 
Data is displayed in Median (Minimum – Maximum) 
NM: Young Normal Group; Ap: D-galactose acceleration model; ApH: D-galactose+HSL acceleration 
Data analysis was continued on muscle fibers, in the form of calculating the average percentage of collagen in 5 
microscopic cross-sectional fields of muscle fibers for each sample with Masson Trichrome staining . Morphologically, 
there were differences in muscle fibers in the NM group, the Ap group, and the ApH group (Figure 4). The morphology 
of collagen distribution (in blue) in muscle tissue in the NM group appeared even and there was no collagen accumulation. 
Meanwhile, in the Ap and ApH groups, collagen accumulation was seen.  

 
(a)  

(b) 
 

(c) 
Figure 4. Comparison of the results of Masson Trichrome histological examination of gastrocnemius 

muscle tissue. 
(a)NM: Young Normal Group; (b) Ap: D-galactose acceleration model; (c) ApH: D-galactose+HSL 

acceleration (scale bar 100µm) 
There were striking structural differences in collagen deposition between the three groups. In the NM group (Figure 1a), 
muscle fibers appeared neatly arranged, dense, and uniform, with a thin blue distribution of interstitial connective tissue 
(both endomysium and perimysium). This condition differed from the Ap group (Figure 1b). A clear morphological 
difference was seen in the form of a smaller muscle fiber diameter, which was exacerbated by massive collagen 
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accumulation in the intercellular space. This accumulation of extracellular matrix or fibrosis is strong evidence of chronic 
oxidative stress due to D-galactose induction, which in turn disrupts the regulation of MMPs (MMP) enzymes and triggers 
pro-fibrotic pathways. 26Microscopic changes in the aging-accelerated muscle were supported by the results of quantitative 
analysis of the percentage of collagen area in the Ap group (34.34 ; 30.21-40.58 ) which was significantly higher than the 
NM group ( 16.84; 15.93-24.82 ) with p = 0.0029 . Interestingly, there was no significant difference between the ApH 
group ( 20.91; 20.47-22.78) and the NM group; p = 0.0002. This proves that supplementation with Hibiscus sabdariffa 
Linn. ethanol extract is able to inhibit structural damage. Visually, muscle fiber density in the ApH group appeared to 
recover and approach its normal condition, followed by reduced collagen deposition when compared to the Ap group. 
This protective effect indicates that the bioactive compounds in HSL, especially anthocyanins and polyphenols as 
antioxidants, effectively dampen and reduce free radicals due to D-galactose toxicity. 27The protective ability of HSL in 
reducing interstitial fibrosis is in line with several previous studies that reported that HSL polyphenol extract is able to 
repair cell organelle damage while suppressing extracellular matrix deposition.28 As shown in Based on the results of the 
muscle strength test, in the first week before termination for the NM group and given D-gal treatment in the Ap group and 
oral administration of D-gal + HSL mixed with drinking water for the ApH group showed that before being given D-gal 
and D-gal + HSL treatment, the difference in muscle strength in the three groups was not too far (Table 3). 

 
Figure 5. Muscle Grip Strength 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Table 4. Muscle Grip Strength 

Measurement Time 
Group 

NM 
grams 

Ap 
grams 

ApH 
grams 

Week 0 (Before Treatment) 317.78 ± 100.7 328.33 ± 89.21 331.94 ± 98.50 
Week 4 - 247.61 ± 69.42 307.39 ± 100.76 
Week 8 (Before Termination) - 205.08 ± 51.38 207.39 ± 87.70 

*p < 0.05 
Data are displayed as Mean ± SD 
NM: Young Normal Group; Ap: D-galactose acceleration model; ApH: D-galactose+HSL acceleration 
 
The results of the statistical test using Two-Way Repeated Measures (RM) ANOVA showed that there was no significant 
interaction between the time factor and the treatment group (p = 0.6674). There was also no difference between the groups 
in the mean muscle strength. There was a decrease in muscle strength in all 3 groups with increasing age, however, a 
significant decrease only occurred in the Ap group, namely between Week 0 and Week 8 (p = 0.0097). This indicates the 
role of accelerated aging by D-galactose in causing a decline in musculoskeletal function that resembles sarcopenia. 
Although in Week 4 the ApH group showed a higher average muscle strength compared to the Ap group, in general there 
was no significant difference (p = 0.4097). Thus, it can be concluded that the administration of Hibiscus sabdariffa Linn. 
extract at this dose or study duration has not been able to provide a statistically significant protective effect in preventing 
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the rate of decline in functional muscle strength due to D-galactose-induced accelerated aging. 
 

Molecularly, the chronic accumulation of free radicals due to D-galactose induces abnormalities and dysfunction 
of the mitochondrial complex in skeletal muscle, which directly triggers a decrease in ATP production and disrupts the 
aerobic metabolism of muscle cells. 29This prolonged energy deficit and oxidative stress damages myocyte integrity, 
triggers muscle fiber atrophy, and triggers pathological extracellular matrix remodeling through thick and massive 
collagen accumulation (fibrosis) in the endomysium and perimysium areas, as visualized in Masson's Trichrome staining 
of the Ap group (Figure 1b).30 In contrast, in the group receiving Hibiscus sabdariffa Linn. (ApH) extract intervention, 
the rate of decline in muscle mechanical functional performance could be better restrained. This protective effect was seen 
in the 4th week observation, which showed that the grip strength value of the ApH group was relatively the same as week 
0. The ability of HSL to maintain contractile function and delay the onset of muscle weakness is related to differences in 
serum MDA levels and proves that the many exogenous antioxidant compounds in HSL such as polyphenols and 
anthocyanins work effectively to cut the lipid peroxidation chain in the sarcolemma and protect the muscle 
macromolecular growth signaling pathway from overtraining stress and oxidative aging stress. 20By attenuating 
intracellular oxidative stress by HSL, interstitial connective tissue homeostasis is restored, which is microscopically 
indicated by the return of gastrocnemius muscle fiber density and a massive reduction in pathological collagen deposition 
(Figure 1c). 
 
CONCLUSION 
 This study shows that supplementation with ethanol extract of Hibiscus sabdariffa Linn. (HSL) has therapeutic 
potential in inhibiting the degeneration process of gastrocnemius muscle in a mouse model of accelerated aging at the 
molecular, histopathological, and functional levels. At the molecular level, the activity of HSL bioactive compounds has 
been shown to be effective in reducing oxidative stress by cutting the lipid peroxidation chain in the sarcolemma, which 
is indicated by a decrease in Malondialdehyde (MDA) levels. This decrease in intracellular oxidative stress has positive 
implications for the morphological defense of tissue structures, as demonstrated by the activity of the MMP-9 enzyme and 
the accumulation of pathological collagen (fibrosis). Although there was no evidence of a difference in grip strength 
between groups, HSL supplementation has been shown to have the potential to inhibit the decline in grip strength. 
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